



Chapter 2

Keyboard Shortcuts for Word 2002  
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To: Display the Assistant balloon (if the Assistant is turned off, F1 opens the 

Help window) 

Press: F1 

To: Select an option; select or clear a check box

Press: ALT+ the letter underlined in an option 

To: Restore the size of the active window after you've maximized it

Press: CTRL+F5 

To: Restore the document window size

Press: CTRL+F5 

To: When more than one window is open, switch to the next window

Press: CTRL+F6 

To: Go to the next window

Press: CTRL+F6 

To: When a document window is not maximized, performs the Move command (on the 

Control menu for the window). Use the arrow keys to move the window, and, when 

finished, press ESC.

Press: CTRL+F7 

To: Choose the Move command (Control menu, or Window shortcut menu)

Press: CTRL+F7 

To: When a document window is not maximized, performs the Size command (on the 

Control menu for the window). Use the arrow keys to resize the window, and, when 

finished, press ESC.

Press: CTRL+F8 

To: Choose the Size command (Control menu, or Window shortcut menu)

Press: CTRL+F8 

To: Minimize a window to an icon (works only for some Microsoft Office programs)

Press: CTRL+F9 

To: A field

Press: CTRL+F9 

To: Insert an empty field

Press: CTRL+F9 

To: Insert an empty field

Press: CTRL+F9 

To: Go to a page, bookmark, footnote, table, comment, graphic, or other location

Press: CTRL+G 

To: Replace text, specific formatting, and special items

Press: CTRL+H 

To: Move to the first preview page when zoomed out

Press: CTRL+HOME 

To: To the beginning of a document

Press: CTRL+HOME 

To: Move to the top or bottom of the selected gallery list.

Press: CTRL+HOME or CTRL+END 

To: Create a nonbreaking hyphen

Press: CTRL+HYPHEN 

To: An optional hyphen

Press: CTRL+HYPHEN 

To: Make letters italic

Press: CTRL+I 

To: Apply italic formatting

Press: CTRL+I 

To: Justify a paragraph

Press: CTRL+J 

To: Insert a hyperlink

Press: CTRL+K 

To: Left align a paragraph

Press: CTRL+L 

To: Move one word to the left

Press: CTRL+LEFT ARROW 

To: One word to the left

Press: CTRL+LEFT ARROW 

To: Indent a paragraph from the left

Press: CTRL+M 

To: Create a new document of the same type as the current or most recent 

document

Press: CTRL+N 

To: Open a document

Press: CTRL+O 

To: Print a document

Press: CTRL+P 

To: To the top of the next page

Press: CTRL+PAGE DOWN 

To: To the top of the previous page

Press: CTRL+PAGE UP 

To: Remove paragraph formatting

Press: CTRL+Q 

To: Right align a paragraph

Press: CTRL+R 

To: Move one word to the right

Press: CTRL+RIGHT ARROW 

To: One word to the right

Press: CTRL+RIGHT ARROW 

To: Save a document

Press: CTRL+S 

To: Display nonprinting characters

Press: CTRL+SHIFT+* (asterisk) 

To: Decrease font size

Press: CTRL+SHIFT+< 

To: Increase font size

Press: CTRL+> 

To: Increase the font size

Press: CTRL+> 

To: Format letters as all capitals

Press: CTRL+A 

To: Open the Address Book

Press: CTRL+B 

To: Copy formatting from text

Press: CTRL+C 

To: Copy formats

Press: CTRL+C 

To: 110

Press: CTRL+D 

To: To the end of a paragraph

Press: CTRL+DOWN ARROW 

To: Turn track changes on or off

Press: CTRL+E 

To: To the end of a document

Press: CTRL+END 

To: A column break

Press: CTRL+ENTER 

To: Change the font

Press: CTRL+F 

To: Activate the ruler

Press: CTRL+F10 

To: Unlock a field

Press: CTRL+F11 

To: Unlock a field

Press: CTRL+F11 

To: Choose the Print command (File menu)

Press: CTRL+F12 

To: Paste the Spike contents

Press: CTRL+F3 

To: Insert the contents of the Spike

Press: CTRL+F3 

To: Edit a bookmark

Press: CTRL+F5 

To: Switch to the previous window

Press: CTRL+F6 

To: Go to the previous window

Press: CTRL+F6 

To: Update linked information in a Microsoft Word source document

Press: CTRL+F7 

To: Update linked information in a Microsoft Word source document

Press: CTRL+F7 

To: Extend a selection or block (then press an arrow key)

Press: CTRL+F8 

To: To a vertical block of text

Press: CTRL+F8, and then use the arrow keys; press ESC to cancel selection mode 

To: Extend a selection (or block)

Press: CTRL+F8, and then use the arrow keys; press ESC to cancel selection mode 

To: Unlink a field

Press: CTRL+F9 

To: Unlink a field

Press: CTRL+F9 

To: Create a message flag

Press: CTRL+G 

To: Apply hidden text formatting

Press: CTRL+H 

To: To the beginning of a document

Press: CTRL+HOME 

To: A nonbreaking hyphen

Press: CTRL+HYPHEN 

To: Format letters as small capitals

Press: CTRL+K 

To: Apply the List style

Press: CTRL+L 

To: Select or unselect one word to the left

Press: CTRL+LEFT ARROW 

To: To the beginning of a word

Press: CTRL+LEFT ARROW 

To: Remove a paragraph indent from the left

Press: CTRL+M 

To: Demote to body text

Press: CTRL+N 

To: Apply the Normal style

Press: CTRL+N 

To: Change the font size

Press: CTRL+SHIFT+P 

To: Apply superscript formatting (automatic spacing)

Press: CTRL+PLUS SIGN 

To: Change the selection to the Symbol font

Press: CTRL+Q 

To: Select or unselect one word to the right

Press: CTRL+RIGHT ARROW 

To: To the end of a word

Press: CTRL+RIGHT ARROW 

To: Apply a style

Press: CTRL+S 

To: Create a nonbreaking space

Press: CTRL+SPACEBAR 

To: A nonbreaking space

Press: CTRL+SPACEBAR 

To: Reduce a hanging indent

Press: CTRL+T 

To: Switch to the previous tab in a dialog box 

Press: CTRL+TAB 

To: To the beginning of a paragraph

Press: CTRL+UP ARROW 

To: Apply copied formatting to text

Press: CTRL+V 

To: Paste formats

Press: CTRL+V 

To: Underline words but not spaces

Press: CTRL+W 

To: Remove paragraph or character formatting

Press: CTRL+SPACEBAR 

To: Turn Chinese IME on 101 keyboard on or off

Press: CTRL+SPACEBAR 

To: Remove manual character formatting

Press: CTRL+SPACEBAR 

To: Create a hanging indent

Press: CTRL+T 

To: Switch to the next tab

Press: CTRL+TAB 

To: When a menu or toolbar is active, move to a task pane. (You may need to 

press CTRL+TAB more than once.)

Press: CTRL+TAB 

To: Switch to the next tab in a dialog box 

Press: CTRL+TAB 

To: When the insertion point is in the message header, select the Send button. 

You can then use the arrow keys to move to the other buttons. To perform the 

action for the selected button or command, press ENTER.

Press: CTRL+TAB 

To: Insert a tab character

Press: CTRL+TAB 

To: Tab characters in a cell

Press: CTRL+TAB 

To: Select a toolbar after pressing F10 or ALT to select the menu bar. When a 

toolbar is selected, select the next or previous toolbar or menu bar.

Press: CTRL+TAB or CTRL+SHIFT+TAB 

To: Make letters underline

Press: CTRL+U 

To: Apply an underline

Press: CTRL+U 

To: One paragraph up

Press: CTRL+UP ARROW 

To: Paste text or an object

Press: CTRL+V 

To: Paste the Clipboard contents

Press: CTRL+V 

To: Close a document

Press: CTRL+W 

To: Close the active window

Press: CTRL+W or CTRL+F4 

To: Cut the selected text or object

Press: CTRL+X 

To: Cut selected text to the Clipboard

Press: CTRL+X 

To: Redo the last action

Press: CTRL+Y 

To: Redo or repeat an action

Press: CTRL+Y 

To: Undo the last action

Press: CTRL+Z 

To: Undo an action

Press: CTRL+Z 

To: Undo the last action

Press: CTRL+Z 

To: Delete one character to the right

Press: DELETE 

To: Select the next book or Help topic

Press: DOWN ARROW 

To: Select the next item in a smart tag menu.

Press: DOWN ARROW 

To: Down one line

Press: DOWN ARROW 

To: Next row

Press: DOWN ARROW 

To: Move among choices in a selected submenu; move among certain options in a 

group of options.

Press: DOWN ARROW or UP ARROW 

To: When a menu or submenu is open, select the next or previous command.

Press: DOWN ARROW or UP ARROW 

To: Move to the end of the entry

Press: END 

To: To the end of a line

Press: END 

To: Perform the action for the selected Show All, Hide All, hidden text, or 

hyperlink

Press: ENTER 

To: Open a selected book or Help topic

Press: ENTER 

To: Perform the action for the selected Show All, Hide All, hidden text, or 

hyperlink

Press: ENTER 

To: Perform the action for the selected item in a smart tag menu.

Press: ENTER 

To: Open the selected menu, or perform the action for the selected button or 

command.  

Press: ENTER 

To: Perform the action assigned to a default button in a dialog box

Press: ENTER 

To: New paragraphs in a cell

Press: ENTER 

To: An AutoText entry

Press: ENTER (after typing the first few characters of the AutoText entry name 

and when the ScreenTip appea 

To: Close an Assistant message or a tip 

Press: ESC 

To: Close the smart tag menu or message.

Press: ESC 

To: Close an open menu. When a submenu is open, close only the submenu.

Press: ESC 

To: Close a selected drop-down list; cancel a command and close a dialog box

Press: ESC 

To: Cancel an action

Press: ESC 

To: Turn extend mode off

Press: ESC 

To: Get Help or the Office Assistant

Press: F1 

To: Activate the menu bar

Press: F10 

To: Select the menu bar, or close an open menu and submenu at the same time.

Press: F10 or ALT 

To: Go to the next field

Press: F11 

To: Go to the next field

Press: F11 

To: Display the Save As dialog box

Press: F12 

To: Choose the Save As command (File menu)

Press: F12 

To: Move text or graphics

Press: F2 

To: Move text or graphics

Press: F2 (then move the insertion point and press ENTER) 

To: Insert an AutoText entry (after Microsoft Word displays the entry)

Press: F3 

To: Repeat the last action

Press: F4 

To: Open the Look in list

Press: F4 or ALT+I 

To: Update the files visible in the Open or Save As dialog box (File menu)

Press: F5 

To: Choose the Go To command (Edit menu)

Press: F5 

To: Switch between the Help topic and the Contents, Answer Wizard,  Index pane

Press: F6 

To: Switch between the Help topic and the Contents, Answer Wizard,  Index pane

Press: F6 

To: Move to a task pane from another pane in the program window (clockwise 

direction). You may need to press F6 more than once.

Press: F6 

To: Go to the next pane or frame

Press: F6 

To: Choose the Spelling command (Tools menu)

Press: F7 

To: Turn extend mode on

Press: F8 

To: Extend a selection

Press: F8 

To: Increase the size of a selection

Press: F8 (press once to select a word, twice to select a sentence, and so 

forth) 

To: Select the nearest character

Press: F8, and then press LEFT ARROW or RIGHT ARROW 

To: To a specific location in a document

Press: F8+arrow keys; press ESC to cancel selection mode 

To: Refresh

Press: F9 

To: Update selected fields

Press: F9 

To: Update selected fields

Press: F9 

To: Open the list if it is closed and move to that option in the list

Press: First letter of an option in a drop-down list 

To: Extend a selection to adjacent cells

Press: Hold down SHIFT and press an arrow key repeatedly 

To: Move to the beginning of the entry

Press: HOME 

To: To the beginning of a line

Press: HOME 

To: When a menu or submenu is visible, select the first or last command on the 

menu or submenu.

Press: HOME or END 

To: Select the first or last command on the menu or submenu.

Press: HOME or END 

To: Switch between languages or keyboard layouts

Press: Left ALT+SHIFT 

To: One character to the left

Press: LEFT ARROW 

To: Select the menu to the left or right. When a submenu is open, switch between 

the main menu and the submenu.

Press: LEFT ARROW or RIGHT ARROW 

To: Move one character to the left or right

Press: LEFT ARROW or RIGHT ARROW 

To: Down one screen (scrolling)

Press: PAGE DOWN 

To: Up one screen (scrolling)

Press: PAGE UP 

To: Scroll up or down in the selected gallery list.

Press: PAGE UP or PAGE DOWN 

To: Move by one preview page when zoomed out

Press: PAGE UP or PAGE DOWN 

To: Copy a picture of the screen to the Clipboard

Press: PRINT SCREEN 

To: Turn Korean IME on 101 keyboard on or off

Press: Right ALT 

To: One character to the right

Press: RIGHT ARROW 

To: When a menu is selected, display the list of commands.

Press: SHIFT+DOWN ARROW 

To: One line down

Press: SHIFT+DOWN ARROW 

To: Select from the insertion point to the end of the entry

Press: SHIFT+END 

To: To the end of a line

Press: SHIFT+END 

To: A line break

Press: SHIFT+ENTER 

To: Start context-sensitive Help or reveal formatting

Press: SHIFT+F1 

To: Review text formatting

Press: SHIFT+F1 (then click the text whose formatting you want to review) 

To: Display a shortcut menu

Press: SHIFT+F10 

To: Open a shortcut menu; open a drop-down menu for the selected gallery item.

Press: SHIFT+F10 

To: Display the shortcut menu for the selected item.

Press: SHIFT+F10 

To: Display a shortcut menu for a selected item such as a folder or file

Press: SHIFT+F10 

To: Display a shortcut menu

Press: SHIFT+F10 

To: Go to the previous field

Press: SHIFT+F11 

To: Go to the previous field

Press: SHIFT+F11 

To: Choose the Save command (File menu)

Press: SHIFT+F12 

To: Copy text

Press: SHIFT+F2 

To: Change the case of letters

Press: SHIFT+F3 

To: Change the case of letters

Press: SHIFT+F3 

To: Repeat a Find or Go To action

Press: SHIFT+F4 

To: To a previous revision

Press: SHIFT+F5 

To: To the location of the insertion point when the document was last closed

Press: SHIFT+F5 

To: Move to the last change

Press: SHIFT+F5 

To: Move to a pane from another pane in the program window (counterclockwise 

direction)

Press: SHIFT+F6 

To: Go to the previous pane or frame

Press: SHIFT+F6 

To: Choose the Thesaurus command (Tools menu, Language submenu)

Press: SHIFT+F7 

To: Reduce the size of a selection

Press: SHIFT+F8 

To: Reduce the selection size

Press: SHIFT+F8 

To: Shrink a selection

Press: SHIFT+F8 

To: Switch between a selected field code and its result

Press: SHIFT+F9 

To: Select from the insertion point to the beginning of the entry

Press: SHIFT+HOME 

To: To the beginning of a line

Press: SHIFT+HOME 

To: Select or unselect one character to the left

Press: SHIFT+LEFT ARROW 

To: One character to the left

Press: SHIFT+LEFT ARROW 

To: One screen down

Press: SHIFT+PAGE DOWN 

To: One screen up

Press: SHIFT+PAGE UP 

To: Select or unselect one character to the right

Press: SHIFT+RIGHT ARROW 

To: One character to the right

Press: SHIFT+RIGHT ARROW 

To: Select the previous hidden text or hyperlink, or the Browser View button at 

the top of a Microsoft Office Web site article 

Press: SHIFT+TAB 

To: Select the previous hidden text or hyperlink, or the Browser View button at 

the top of a Microsoft Office Web site article 

Press: SHIFT+TAB 

To: Move to the previous option or option group

Press: SHIFT+TAB 

To: Select the previous field or button in the e-mail header

Press: SHIFT+TAB 

To: Select the preceding cell's contents

Press: SHIFT+TAB 

To: One cell to the left (in a table)

Press: SHIFT+TAB 

To: Previous cell in a row

Press: SHIFT+TAB 

To: One line up

Press: SHIFT+UP ARROW 

To: Perform the action assigned to the selected button; check or clear the 

selected check box

Press: SPACEBAR 

To: Open the selected menu, or perform the action assigned to the selected 

button.

Press: SPACEBAR or ENTER 

To: Show the Assistant in a wizard or dialog box. To hide the Assistant, press 

SPACEBAR again. Note that not all wizards or dialog boxes have Help provided by 

the Assistant.

Press: SPACEBAR, with the Help button selected 

To: Move to the Help button in the wizard button in the wizard

Press: TAB 

To: Select the next hidden text or hyperlink, or Show All or Hide All at the top 

of a topic

Press: TAB 

To: Select the next hidden text or hyperlink, or Show All or Hide All at the top 

of a topic

Press: TAB 

To: Move to the next option or option group

Press: TAB 

To: Move between options or areas in the dialog box 

Press: TAB 

To: When the insertion point is in the message header, select the next box in 

the e-mail header. When the last box in the e-mail header is active, TAB selects 

the body of the document or message.

Press: TAB 

To: Select the next cell's contents

Press: TAB 

To: One cell to the right (in a table)

Press: TAB 

To: Next cell in a row

Press: TAB 

To: When a task pane is active, select the next or previous option in the task 

pane.

Press: TAB or SHIFT+TAB 

To: When a toolbar or menu bar is selected, select the next or previous button 

or menu.

Press: TAB or SHIFT+TAB 

To: Hide or display character formatting

Press: The slash (/) key on the numeric keypad 

To: Select the previous book or Help topic

Press: UP ARROW 

To: Select the previous item in a smart tag menu.

Press: UP ARROW 

To: Up one line

Press: UP ARROW 

To: Previous row

Press: UP ARROW 

To: Open the Correction dialog box

Press: Windows logo key +C 

To: Turn handwriting on or off

Press: Windows logo key +H 

To: Switch between Voice Command mode and Dictation mode

Press: Windows logo key +T 

To: Switch microphone on or off

Press: Windows logo key +V 

To: Open the Address Book in the To field 

Press: ALT+. (period) 

To: Turn Japanese Input Method Editor (IME) on 101 keyboard on or off 

Press: ALT+~ 

To: Go to the previous folder 

Press: ALT+1 

To: Open the folder up one level from the open folder (Up One Level button) 

Press: ALT+2 

To: Close the dialog box and open your World Wide Web search page (Search the 

Web button) 

Press: ALT+3 

To: Delete the selected folder or file (Delete button) 

Press: ALT+4 

To: Create a new subfolder in the open folder (Create New Folder button) 

Press: ALT+5 

To: Select an entire table 

Press: ALT+5 on the numeric keypad (with NUM LOCK off) 

To: Switch between List, Details, Properties, and Preview views (Click the arrow 

next to Views) 

Press: ALT+6 

To: Show the Tools menu (Tools button) 

Press: ALT+7 or ALT+L 

To: Switch to the Answer Wizard tab 

Press: ALT+A 

To: If the Bcc field is visible, open the Address Book in the Bcc field. To 

display the Bcc field, open the Address Book for any field and insert or type a 

name in the Bcc box. 

Press: ALT+B 

To: Switch to the Contents tab 

Press: ALT+C 

To: When the insertion point is in the message header, open the Address Book in 

the Cc field

Press: ALT+C 

To: Remove a command from a menu. When you type this shortcut key and then 

select a menu command, the command is removed. You can add the menu command back 

to the menu if you change your mind.

Press: ALT+CTRL+- (dash key) 

To: Customize the shortcut key for a menu command. When you type this shortcut 

key and then select a menu command, the Customize Keyboard dialog box opens so 

you can add, change, or remove the shortcut key.

Press: ALT+CTRL++ (plus key on numeric keypad) 

To: Add a toolbar button to a menu. When you type this shortcut key and then 

click a toolbar button, Microsoft Word adds the button to the appropriate menu. 

For example, click Bullets on the Formatting toolbar to add the Bullets command 

to the Format menu.

Press: ALT+CTRL+= (equal sign) 

To: Apply the Heading 1 style

Press: ALT+CTRL+1 

To: Apply the Heading 2 style

Press: ALT+CTRL+2 

To: Apply the Heading 3 style

Press: ALT+CTRL+3 

To: The copyright symbol

Press: ALT+CTRL+C 

To: Insert an endnote

Press: ALT+CTRL+D 

To: Insert an footnote

Press: ALT+CTRL+F 

To: Browse through a document

Press: ALT+CTRL+HOME 

To: Switch in or out of print preview

Press: ALT+CTRL+I 

To: Start AutoFormat

Press: ALT+CTRL+K 

To: Insert a  LISTNUM field

Press: ALT+CTRL+L 

To: Insert a comment

Press: ALT+CTRL+M 

To: Switch to normal view

Press: ALT+CTRL+N 

To: Switch to outline view

Press: ALT+CTRL+O 

To: Switch to print layout view

Press: ALT+CTRL+P 

To: To the end of the window

Press: ALT+CTRL+PAGE DOWN 

To: To the top of the window

Press: ALT+CTRL+PAGE UP 

To: An ellipsis

Press: ALT+CTRL+period 

To: The registered trademark symbol

Press: ALT+CTRL+R 

To: Split the document window

Press: ALT+CTRL+S 

To: To the end of a window

Press: ALT+CTRL+SHIFT+PAGE DOWN 

To: The trademark symbol

Press: ALT+CTRL+T 

To: Repeat find (after closing Find and Replace window)

Press: ALT+CTRL+Y 

To: Go back to a page, bookmark, footnote, table, comment, graphic, or other 

location

Press: ALT+CTRL+Z 

To: Display more Help topics in the Assistant list 

Press: ALT+DOWN ARROW 

To: Open a selected drop-down list 

Press: ALT+DOWN ARROW 

To: Last cell in a row 

Press: ALT+END 

To: Go to the next field 

Press: ALT+F1 

To: Maximize the program window 

Press: ALT+F10 

To: Display Microsoft Visual Basic code 

Press: ALT+F11 

To: Create AutoText 

Press: ALT+F3 

To: Create an AutoText entry 

Press: ALT+F3 

To: Close the Help window

Press: ALT+F4 

To: Quit Microsoft Word

Press: ALT+F4 

To: Restore the program window size

Press: ALT+F5 

To: Find the next misspelling or grammatical error. The Check spelling as you 

type check box must be selected (Tools menu, Options dialog box, Spelling & 

Grammar tab).

Press: ALT+F7 

To: Run a macro

Press: ALT+F8 

To: Switch between all field codes and their results

Press: ALT+F9 

To: Switch between all field codes and their results

Press: ALT+F9 

To: First cell in a row

Press: ALT+HOME 

To: Switch to the Index tab

Press: ALT+I 

To: Go to the Subject field

Press: ALT+J 

To: When the insertion point is in the message header, check the names on the 

To, Cc, and Bcc lines against the Address Book.

Press: ALT+K, CTRL+K 

To: Go back one page

Press: ALT+LEFT ARROW 

To: Select a Help topic from the list the Assistant displays. ALT+1 is the first 

topic, ALT+2 is the second, and so on.

Press: ALT+number 

To: Display the Options menu to access any Help toolbar command

Press: ALT+O 

To: Display the previously viewed topic

Press: ALT+O, and then press B 

To: Display the next topic in a previously displayed sequence of topics

Press: ALT+O, and then press F 

To: Return to the specified home page

Press: ALT+O, and then press H 

To: Open the Internet Options dialog box for Microsoft Internet Explorer, where 

you can change accessibility settings

Press: ALT+O, and then press I 

To: Print all topics in a book or a selected topic only

Press: ALT+O, and then press P 

To: Refresh the topic (useful if you have linked to a Web page)

Press: ALT+O, and then press R 

To: Stop the Help window from opening a Help topic (useful if you want to stop a 

Web page from downloading)

Press: ALT+O, and then press S 

To: Hide or show the pane with the Contents, Answer Wizard, and Index tabs

Press: ALT+O, and then press T 

To: Open the Microsoft Outlook Message Options dialog box

Press: ALT+P 

To: Last cell in a column

Press: ALT+PAGE DOWN 

To: First cell in a column

Press: ALT+PAGE UP 

To: Copy a picture of the selected window to the Clipboard

Press: ALT+PRINT SCREEN 

To: Go forward one page

Press: ALT+RIGHT ARROW 

To: Send the active document or message

Press: ALT+S 

To: Show all headings with the Heading 1 style

Press: ALT+SHIFT+1 

To: Expand or collapse all text or headings

Press: ALT+SHIFT+A 

To: Remove the document window split

Press: ALT+SHIFT+C 

To: Close the Reviewing Pane if it is open

Press: ALT+SHIFT+C 

To: Insert a DATE field 

Press: ALT+SHIFT+D 

To: Move selected paragraphs down

Press: ALT+SHIFT+DOWN ARROW 

To: Edit a mail-merge data document

Press: ALT+SHIFT+E 

To: Insert a merge field

Press: ALT+SHIFT+F 

To: Go to the previous field

Press: ALT+SHIFT+F1 

To: Display the menu or message for a smart tag. If more than one smart tag is 

present, switch to the next smart tag and display its menu or message.

Press: ALT+SHIFT+F10 

To: Display Microsoft Visual Studio code

Press: ALT+SHIFT+F11 

To: Choose the Save command (File menu)

Press: ALT+SHIFT+F2 

To: Run GOTOBUTTON or MACROBUTTON from the field that displays the field results

Press: ALT+SHIFT+F9 

To: Mark a table of authorities entry (citation)

Press: ALT+SHIFT+I 

To: Preview a mail merge

Press: ALT+SHIFT+K 

To: Show the first line of body text or all body text

Press: ALT+SHIFT+L 

To: Promote a paragraph

Press: ALT+SHIFT+LEFT ARROW 

To: Print the merged document

Press: ALT+SHIFT+M 

To: Collapse text under a heading

Press: ALT+SHIFT+MINUS SIGN 

To: Show all headings up to Heading n

Press: ALT+SHIFT+n 

To: Merge a document

Press: ALT+SHIFT+N 

To: Mark a table of contents entry

Press: ALT+SHIFT+O 

To: Insert a PAGE field

Press: ALT+SHIFT+P 

To: Expand text under a heading

Press: ALT+SHIFT+PLUS SIGN 

To: Copy the header or footer used in the previous section of the document

Press: ALT+SHIFT+R 

To: Demote a paragraph

Press: ALT+SHIFT+RIGHT ARROW 

To: Insert a TIME field

Press: ALT+SHIFT+T 

To: Switch to the previous window

Press: ALT+SHIFT+TAB 

To: Move selected paragraphs up

Press: ALT+SHIFT+UP ARROW 

To: Mark an index entry

Press: ALT+SHIFT+X 

To: Display the window shortcut menu (Control menu).

Press: ALT+SPACEBAR 

To: Switch to the next window

Press: ALT+TAB 

To: Display previous Help topics in the Assistant list

Press: ALT+UP ARROW 

To: Move between options in an open drop-down list, or between options in a 

group of options

Press: Arrow keys 

To: Move around the preview page when zoomed in

Press: Arrow keys 

To: Delete one character to the left

Press: BACKSPACE 

To: Select a column

Press: Click in the column's top or bottom cell. Hold down SHIFT and press the 

UP ARROW or DOWN ARROW key r 

To: Decrease the font size by 1 point

Press: CTRL+[ 

To: Move between a master document and its subdocuments

Press: CTRL+\\ 

To: Increase the font size by 1 point

Press: CTRL+] 

To: Add or remove one line space preceding a paragraph

Press: CTRL+0 (zero) 

To: Add or remove one line space preceding a paragraph

Press: CTRL+1 

To: Double-space lines

Press: CTRL+2 

To: Set 1.5-line spacing

Press: CTRL+5 

To: To include the entire document

Press: CTRL+A 

To: Display Microsoft System Information

Press: CTRL+ALT+F1 

To: Open command (File menu)

Press: CTRL+ALT+F2 

To: Make letters bold

Press: CTRL+B 

To: Apply bold formatting

Press: CTRL+B 

To: Delete one word to the left

Press: CTRL+BACKSPACE 

To: Copy the selected text or object

Press: CTRL+C 

To: Copy text or graphics

Press: CTRL+C 

To: Display the Office Clipboard

Press: CTRL+C, CTRL+C 

To: Change the formatting of characters (Font command, Format menu)

Press: CTRL+D 

To: Delete one word to the right

Press: CTRL+DELETE 

To: Display the full set of commands on the task pane menu.

Press: CTRL+DOWN ARROW 

To: When a shortened menu is open, display the full set of commands.

Press: CTRL+DOWN ARROW 

To: One paragraph down

Press: CTRL+DOWN ARROW 

To: Center a paragraph

Press: CTRL+E 

To: Move to the last preview page when zoomed out

Press: CTRL+END 

To: To the end of a document

Press: CTRL+END 

To: A page break

Press: CTRL+ENTER 

To: Apply subscript formatting (automatic spacing)

Press: CTRL+EQUAL SIGN 

To: Find text, formatting, and special items

Press: CTRL+F 

To: Maximize or restore a selected window

Press: CTRL+F10 

To: Maximize the document window

Press: CTRL+F10 

To: Lock a field

Press: CTRL+F11 

To: Display the Open dialog box

Press: CTRL+F12 

To: Choose the Open command (File menu)

Press: CTRL+F12 

To: Choose the Print Preview command (File menu)

Press: CTRL+F2 

To: Cut to the Spike

Press: CTRL+F3 

To: Close the window

Press: CTRL+F4 


